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DraftSight 
Essentials
An introductory guide to learn essential tips to make 
the most of DraftSight tools and productivity  
features. DraftSight offers multiple product options 
to support the needs of your business. To see which  
features are available in each, visit DraftSight.com  
or see our Feature Matrix. 
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https://www.draftsight.com/product/features


Viewing 
Navigating within your DraftSight drawing is easiest using the scroll wheel on your mouse. Scroll forward to zoom in, and 
backward to zoom out. The location of the zoom will center around the location of your cursor. Holding the wheel down will 
allow you to Pan around the drawing, and double clicking the scroll wheel will zoom to the extents of the drawing.

All of this can be done while you’re in a command, which creates a fast and intuitive way to move about in your drawing.

If you don’t have a mouse with a scroll wheel, these and other navigation commands can be found in the View tab  
of the Ribbon, or you can simply type them into the Command Window.
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DraftSight Essential Tips Video – Zoom and Pan with Mouse

https://www.youtube.com/watch?v=vezFqddDqUc&list=PLjaydrZgNVFzoQv_aX_8KVtV7Ca2YIfXL&index=4


Geometry 
DraftSight provides you with all the tools you need to create your 2D designs. From the Draw panel of the Home tab, you have 
access to tools such as Line, Polyline, Circle, Arc, Ellipse, Hatch and more. Lines are better thought of as individual segments, 
while a Polyline is a connected group of lines or arcs that comprise a single entity.

The Annotate tab gives you access to tools like Note and SimpleNote, which allow you to add textual entities to your drawing.

Most of these commands have various options which can affect their creation and display. Keep an eye on the  
Command Window for these options along with prompts which can help you create your entity.

DraftSight Essential Tips Video – The Difference Between a Line and a Polyline
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https://www.youtube.com/watch?v=bu0GVpt5Paw&list=PLjaydrZgNVFzoQv_aX_8KVtV7Ca2YIfXL&index=1


ESnaps  
Ensure your drawings and designs are accurate by using 
DraftSight’s EntitySnaps (ESnaps) to detect and snap to 
geometric definition points on drawing entities. For ex-
ample, you can snap to the Intersection of two lines, the 
Midpoint of a line, or to the Center Point of a circle.

DraftSight allows you to set up your favorite set of 
ESnaps as shown below. You can then toggle your set on 
or off either from the Status Bar, or by pressing F3.

You can also quickly access them as needed whenever 
you’re prompted for a point. Just press Shift and  
Right-click to display the Entity Snap popup menu.
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DraftSight Essential Tips Video - Esnaps

https://www.youtube.com/watch?v=GTvWIZYd3Ns&list=PLjaydrZgNVFzoQv_aX_8KVtV7Ca2YIfXL&index=3


Types of ESnaps
Entity Snap Mode Abbrevation Marker Description Example

Center cen Snaps to the center of a Circle, Ellipse, Ring, or Arc.

Endpoint end
Snaps to the end point of a line, Arc or other entity. Planes or 
edges of solids can be recognized by Endpoint mode. The mode 
does not differentiate between the start or end point of an 
entity.

Extension ext

Snaps to the extension of an entity or to the intersection of the 
extension of two entities. A temporary extension line or arc 
displays as a dotted line when you pass the pointer the exten-
sion. To snap to the extension of two entities, first moved the 
pointer over the end point of an entity. The entity is marked for 
extension. Then move the pointer over the end point of another 
entity. This enityt is marked tooo. Finally, move the pointer 
near the intersection of the extensions. An X indicates the 
intersection. Click to accept

Insertion point ins Snaps to the insertion point of a Block insrtion, an attribute, or 
a Text entity.

Intersection int Snaps to the intersection points of Lines, Arcs, and Circles, or 
any combination of them.

Midpoint mid
Snaps to the mid point of a Line or an Arc. PLanes, or the edges 
of solids, are also interpreted as lines can be snapped ot with 
the Midpoint mode.

Node nod Snaps to a point entity, dimension definition point, or  
Dimension text origin.
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Entity Snap Mode Abbrevation Marker Description Example

Nearest nea

Snaps to the next situated point of an entity when at least ones 
point of the entity lies within the borders of the GravityBpx. 
If you select a point without using Nearest mode, the selected 
point might not be on the desired entity. This mode ensures 
that the entities share a point with the specified entity.

Parallel par

Constrains a linear entity to be parallel to another linear entity. 
When prompted to specify a second or next point whe ndrawing 
a vector, move the pointer over an existing linear entity until you 
see the Parallel EntitySnap marker. Move the pointer close to a 
parallel poistion. A dotted line appears, indicating the parallel 
ESnap. Click the second point of the line on the parallel.

Perpendicular per

Requirs that a start point for a funstion has been selected. Ac-
tivating the EntitySnap mode relates this point to the snapped 
point. For instance, select the end point for the perpendicular, 
and Perpendicular mode is activated. The result is a perpendic-
ularLine from the end point to the selcted entity.

Quadrant qua

Snaps to the nearest quadrant of a Circle or Arc. Quadrants refer 
to the points of a Circle or Arc of the circumference at 0o, 9o, 
180o and 270o. These are intersecting pointsof the axes of a 
coordinates system upon whose origin lies at the center of the 
Circle or Arc with the circumference of the Circle or Arc. Only 
the next visible quadrant of an Arc an be snapped.

Tangent tan

Requires that a start point for a function has been selected. 
Activating the EntitySnap mode relates this point to the snapped 
point.For instance, to create a Line tangent to a Circle, select the 
end point for the tangent Line, and Tangent mode is activated. The 
result is a tangent Line from the end point to the chosen entity.

Visual intersection appint

Snaps to the location in the plan view of the current coordinate 
sysytem wher two entities would intersect if they were projected 
onto the plan view. In 3D space, Visual Intersection mode snaps to 
twoentities that might or might not actually intersect, whereas, 
in 2D draftling, it snaps to the projected intersection of two Line 
entities. If the GravityBox covers only one drawing entity when 
snapping, you are prompted to select a second entity.

Types of ESnaps, continued
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Modify
Once you’ve drawn your geometry, and ensured their accuracy with ESnaps, you will eventually need to modify them.  
DraftSight provides all the tools you’ll need to change the shape of your entities, right from the Modify panel of the Home tab.

You can Copy, Move, Stretch or Scale your entities. Break, Split or Weld 
them, create Offsets, Patterns, or maybe you need to Extend or Trim 
them. And if you do, you’ll no doubt find tremendous value in using  
PowerTrim, which you can find only in DraftSight.

Of course, entities aren’t just geometry, they also have various properties 
that you may need to modify, such as their Layer, LineColor, LineStyle, 
or LineWeight. All these are easily changed from the Properties Palette. 
If it’s not on, you can easily toggle its display by either pressing CTRL-1 on 
the keyboard, or just select the entity, right-click, and choose Properties.
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DraftSight Essential Tips Video – PowerTrim  

https://www.youtube.com/watch?v=_WXhLjpVJF4&list=PLjaydrZgNVFzoQv_aX_8KVtV7Ca2YIfXL&index=8


Layers 
A fundamental element of a professional drawing is using layers to organize your 
work. You can organize a drawing by creating layers to group related drawing 
elements, such as walls, windows, or doors. They can also serve to separate types 
of annotation, such as notes and dimensions.

Each Layer has LineColor, LineStyle, and LineWeight properties. Anything you 
draw on the Layer adopts the layer’s properties unless you explicitly set a  
LineColor, LineStyle, or LineWeight other than those of the active Layer.  
Learn more about Layers on the DraftSight blog. 

This drawing is a floor plan of a small house. Each group of entities is a different 
color and represents a separate layer. 

The Layers Manager provides easy access to all the functions you’ll need to  
create and manage your layers, along with their visibility, properties, and  
behavior. This Layers Manager shows the layers used in the example drawing.
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DraftSight Essential Tips Video - Layers

https://www.youtube.com/watch?v=vTmyaXpYUSA&list=PLjaydrZgNVFzoQv_aX_8KVtV7Ca2YIfXL&index=5


Inquiry Tools 
DraftSight has numerous Inquiry Tools that allow you to quickly query various geometrical aspects of your drawing entities. 

You can find them on the Utilities panel of the Manage tab.

 

Get Distance lists the distance between a start point and an endpoint.

Get Area gives the area and perimeter of an entity.

Get Properties view details of an entity, including Type, Layer, LineColor, LineStyle, LineWeight, Mode (model or sheet), its 
Coordinates, and other details depending on its type.

Coordinates click on a point for its X, Y and Z Coordinates. 

Get Mass Properties calculates and displays the mass properties of 3D Solids and Regions.
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Viewports and Sheets 
The DraftSight interface consists of Model Space, which is where you create your full-scale drawings, and Sheet Space,  
which is where you set up your design for annotation and plotting.

You can view your design in Sheet Space through Viewports. You can create as many as you need, and they can even be  
different scales. Typically, title blocks and annotations are done in Sheet Space, and DraftSight can ensure that notes and  
dimensions are scaled accurately based on the Viewport.

In this example, the Viewport on the left is zoomed and scaled to see the overall design in Model Space, but the Viewport on 
the right is zoomed into the detail callout and scaled up.
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Note and SimpleNote 
Add textual annotations to your DraftSight drawings with the powerful features available to you with the Note tool. You can 
have full control of the appearance of your text entities. With Notes, your annotations appear as formatted blocks of text,  
allowing you to easily change things like the style or font, size, alignment. You can add special characters or even create  
numbered or bulleted lists. Editing is as easy as double clicking your Note block, which displays the built-in Note Formatting 
popup toolbar.

If you need to a single line of text that is based on the current TextStyle, use SimpleNote instead. Just click your start point, 
agree to a couple of prompts (or change them), and start typing. Click Enter twice to exit the command, or once to make a new, 
independent line of text below the first. Editing is even simple – double click the text and the entire line will highlight, allowing 
you to begin editing immediately.
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DraftSight Essential Tips Video - Note 

DraftSight Essential Tips Video - SimpleNote 

https://www.youtube.com/watch?v=EF-T9Du3BqI&list=PLjaydrZgNVFzoQv_aX_8KVtV7Ca2YIfXL&index=6
https://www.youtube.com/watch?v=QBSW7vtx_XA&list=PLjaydrZgNVFzoQv_aX_8KVtV7Ca2YIfXL&index=7


Dimensioning 
With DraftSight, you can dimension your drawings faster than ever with the new SmartDimension tool. Using  
SmartDimension, you no longer need to pre-determine which Dimension command to use, just click on your entity,  
and it will use the proper type based on that entity.

With SmartDimension, you’ll save time by not having to continually end one Dimension command to start another.  
You can find it in the Dimensions panel of the Annotate tab.
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DraftSight Essential Tips Video – Smart Dimension

https://www.youtube.com/watch?v=GHZ7PiAZMiM&list=PLjaydrZgNVFzoQv_aX_8KVtV7Ca2YIfXL&index=2


Blocks  
A block is a named collection of entities that typically represent an object. Perhaps 
it’s a chair, a door, or even a valve symbol. Whenever you need to show a group of 
entities in multiple locations, it’s best to turn them into a block. 

Blocks are stored in the drawing in which they were created but can easily be  
exported out to a new DWG file for use by others. In fact, any DWG file can be  
inserted into a DraftSight DWG file, and it will become a block within that file.

Using blocks in your drawings not only helps ensure the consistent look of  
your object or symbol, but also reduces the overall file size, which can impact  
performance.

Creating your Blocks 
Making your own blocks is easy, but there are a few rules to follow. Typically, the 
entities that are in the block are on Layer 0. This method allows those entities to 
take on the properties of the current layer when LineColor and LineStyle and  
LineWeight are set to ByLayer. Make sure you choose an insertion point that 
makes sense for your block and select the units you used to create your block, 
which will ensure that it will scale correctly when used in drawing with other  
unit settings.

Naming and Managing Blocks
In time, you may develop a large library of blocks, so you’ll want to have a good 
naming scheme. Consider things like its name, function, size, etc. in your name.  
It’s usually best to make it descriptive, as others will need to understand what it is. 

There are a couple of schools of thought to manage a block library. Some like to 
have a folder full of individual DWG’s where each file is a single block. While others 
prefer to create a single drawing with each block defined within it. 

Whichever method you choose, make sure the library is accessible to your entire 
team by placing it in a shared network drive, and remember to consider your  
naming scheme as you’ll want the list to sort in a logical manner.
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Dynamic Blocks  
DraftSight now supports inserting and manipulating AutoCAD® Dynamic Blocks. When selected, these types of blocks display 
special grips that allow you to change its size or shape, change its orientation, or even choose how it is displayed. 

In the image below, the selected door block displays several dynamic grips. By editing just two of them, you can change the 
display and orientation of the door. Here, we choose a new Visibility State with the down arrow grip, and then change the 
direction of swing with the Flip grip.

 

Using Dynamic Blocks can not only save you time but also reduce the size of your drawing file since you don’t have to have a 
separate block for every design condition the block might require.
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AutoCAD® is a registered trademark of Autodesk, Inc.



External Reference Files (XRefs) 
If your workflow includes attaching  
external DWG files as a reference (XRefs), 
you can continue to use them, as  
DraftSight fully supports them, along  
with all the features you may be used to.

You can choose between Overlay and  
Attach, choose what kind of pathing to use, 
clip them, fully open them from the host 
drawing, or choose to edit in place.  
However, you interact with XRefs, you’ll 
feel right at home in DraftSight.

You’re not confined to just DWG files  
either, as you might expect, DraftSight 
also supports other file types, such as DGN 
and PDF, along with most common image 
formats such as JPG, TIF, etc.

16



DWG File format 
DraftSight uses and fully supports the DWG file 
format. Anything you’re used to doing with a 
DWG, you can do in DraftSight. 

So, go ahead and keep your DWG files lean 
and fast using the Clean (Purge) command to 
remove unused entities and styles. Maintain 
your DWG’s integrity by using Error Check 
(Audit) on occasion.

Feel free to save your DWG file to any previous 
format you desire – all the way back to R12! 
Use it to create a DWS file (Standards) or keep 
yourself organized by saving to a DWT file 
(Template).

You can Import and Export your DWG to many of the most popular file formats, including the industry standard, DXF – again,  
all the way back R12 if you need to.

And don’t worry if your current CAD system is customized using AutoLISP®, Visual LISP®, or other API’s as DraftSight  
will handle those for you too.
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AutoLISP® and Visual LISP® are registered trademarks of Autodesk, Inc.



Maximize Resources and Improve Productivity 
DraftSight has been on the market for over ten years under SOLIDWORKS, a world leader in design and engineering software, 
and has won the trust of millions of users worldwide. Companies’ trust DraftSight 2D CAD with the productivity tools, function-
ality, and file compatibility needed to create, edit, view, and mark up any kind of DWG file quickly and efficiently. DraftSight pro-
vides comparable, if not greater capabilities than alternative CAD products with the flexibility of network licensing and support 
for organizations.

Our 3DEXPERIENCE® platform powers our brand applications, serving 11 industries, and provides a rich portfolio of industry 
solution experiences. 
Dassault Systèmes, the 3DEXPERIENCE Company, is a catalyst for human progress. We provide business and people with collaborative virtual environments to imagine sustainable innovations. By creating 
‘virtual experience twins’ of the real world with our 3DEXPERIENCE platform and applications, our customers push the boundaries of innovation, learning and production. 

Dassault Systèmes’ 20,000 employees are bringing value to more than 270,000 customers of all sizes, in all industries, in more than 140 countries. For more information, visit www.3ds.com.

Europe/Middle East/Africa
Dassault Systèmes
10, rue Marcel Dassault
CS 40501
78946 Vélizy-Villacoublay Cedex
France

Americas
Dassault Systèmes
175 Wyman Street
Waltham, Massachusetts
02451-1223
USA

Asia-Pacific
Dassault Systèmes K.K.
ThinkPark Tower
2-1-1 Osaki, Shinagawa-ku,
Tokyo 141-6020
Japan ©
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Additional Resources

Visit our website
https://www.draftsight.com

DraftSight Free Trial
https://www.draftsight.com/freetrial

Request a quote
https://www.draftsight.com/request-quote

Purchase DraftSight now
https://go.3ds.com/LhA 

Follow us

Facebook
https://www.facebook.com/draftsight

Twitter
https://www.twitter.com/draftsight

LinkedIn
https://www.linkedin.com/showcase/draftsight

YouTube
https://www.youtube.com/draftsight

Instagram 
https://www.instagram.com/draftsight_official

https://www.draftsight.com/
https://www.draftsight.com/freetrial
https://www.draftsight.com/freetrial
https://www.draftsight.com/request-quote
https://go.3ds.com/LhA
https://go.3ds.com/LhA
https://www.facebook.com/DraftSight/
https://twitter.com/draftsight
https://www.linkedin.com/showcase/draftsight/
https://www.youtube.com/c/DraftSight2DCAD
https://www.facebook.com/DraftSight/

